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PEcAn v1.4.7 Hands-On Demo 
 

In the following demos, URL is the web address of a PEcAn server and will refer to 

one of the following: 

 If you are doing a live demo with the PEcAn team, URL was provided 

 If you downloaded the PEcAn VM, URL = localhost:6480 

 If you are running PEcAn on Amazon AWS, URL is the Public IP 

 If you installed PEcAn on your server, URL is your server’s IP 

 

Demo 1: Single-site model run 

 

1. Start PEcAn:  Enter URL/pecan in your web browser 
 

   
 

Click the ‘Next’ button to move to the “Site Selection” page. 

 

  

Objective: 

 

We will begin by exploring a set of web-based tools that are designed to run single-site model runs. 

A lot of the detail about what’s going on under the hood, and all the outputs that PEcAn produces, 

are left to Demo 2. This demo will also demonstrate how to use PEcAn outputs in additional 

analyses outside of PEcAn. 

 

https://pecan.gitbooks.io/pecan-documentation/content/users_guide/basic_users_guide/Getting-started.html#working-with-the-pecan-vm
https://pecan.gitbooks.io/pecan-documentation/content/users_guide/basic_users_guide/Getting-started.html#using-amazonweb-servicesaws
https://pecan.gitbooks.io/pecan-documentation/content/installation/Installing-PEcAn.html
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2. Site Selection 

 

 
 

 

1. Host: Select the local machine “pecan64” Other options exist if you’ve configured PEcAn 

to run models on remote servers.  

2. Model: Select SIPNET from the available models because it is quick & simple. 

3. Site Group: To filter sites, you can select a specific group of sites. For this tutorial we will 

use Ameriflux. 

4. Conversion: Select the conversion check box, to show all sites that PEcAn is capable of 

generating model drivers for automatically. By default (unchecked), PEcAn only displays 

sites where model drivers already exist in the system database 

5. Site: For this tutorial, type US-NR1 in the search box to display the Niwot Ridge Ameriflux 

site (US-NR1), and then click on the pin icon. When you click on a site’s flag on the map, it 

will give you the name and location of the site and put that site in the “Site:” box on the left 

hand site, indicating your current selection.  

6. Click “Next” 

  

https://pecan.gitbooks.io/pecan-documentation/content/users_guide/advanced_users_guide/Enabling-Remote-Execution.html
https://pecan.gitbooks.io/pecan-documentation/content/models/
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3. Run Specification 
 

Next we will specify settings required to run the model. Be aware that the inputs required for 

any particular model may vary somewhat so there may be addition optional or required input 

selections available for other 

models. 

 

1. PFT (Plant Functional Type):  
Niwot Ridge is temperate 

conifer. Available PFTs will 

vary by model and some models 

allow multiple competing PFTs 

to be selected 

2. Start/End Date: Select 

2004/01/01 to 2007/12/31. In 

general, be careful to select 

dates for which there is 

available driver data. 

3. Weather Data: Select “Use 

Ameriflux” from the available 

meteorological drivers 

4. Optional Settings: leave all 

blank for demo run  

1. Email sends a message 

when the run is complete. 

2. Use Brown Dog will use the 

Brown Dog web services in order to do input file conversions. (Note: Required if you 

select Use NARR for Weather Data) 

3. Edit pecan.xml allows you to configure advanced settings via the PEcAn settings file  

4. Edit model config pauses the workflow after PEcAn has written all model specific 

settings but before the model runs are called and allows users to configure any 

additional settings internal to the model.  

5. Advanced Setup controls ensemble and sensitivity run settings discussed in Demo 2. 

5. Click Next to start the model run. 

6.  You will see a data policy statement if you selected a data source with a policy. Agreeing to 

the policy is required prior to starting the run. 

 

If you get an error in your run today it is probably simplest to start over and try 

changing options and re-running (e.g. with a different site or PFT), as time does not 

permit detailed debugging. 
  

https://pecan.gitbooks.io/pecan-documentation/content/data/meteorology.html
https://pecan.gitbooks.io/pecan-documentation/content/data/meteorology.html
https://pecan.gitbooks.io/pecan-documentation/content/users_guide/advanced_users_guide/PEcAn-Configuration.html
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4. Model Run Workflow 
 

 
1. MET Process: First, PEcAn will download meteorological data based on the type of the 

Weather Data you chose, and process it into the specific format for the chosen model 

2. TRAIT / META: PEcAn then estimates model parameters by performing a meta-analysis 

of the available trait data for a PFT. TRAIT will extract relevant trait data from the database. 

META performs a hierarchical Bayes meta-analysis of available trait data (1). The output of 

this analysis is a probability distribution for each model parameter. PEcAn selects the 

median value of this parameter as the default, but in Demo 2 we will see how PEcAn can 

use this parameter uncertainty to make probabilistic forecasts and assess model sensitivity 

and uncertainty. Errors at this stage usually indicate errors in the trait database or incorrectly 

specified PFTs (e.g. defining a variable twice). 

3. CONFIG: writes model-specific settings and parameter files 

4. MODEL: runs model.  

5. OUTPUT: All model outputs are converted to standard netCDF format  

6. ENSEMBLE & SENSITIVITY: If enabled post-process output for these analyses 

 

Congratulations! If you got this far, you have managed to run an ecosystem model without 

ever touching a line of code! Now it’s time to look at the results.  When the workflow is 

done click Finished. 

 

FYI, adding a new model to PEcAn does not require modification of the model’s code, just 

the implementation of a wrapper function. 

  

http://nacp.ornl.gov/MsTMIP_variables.shtml
https://pecan.gitbooks.io/pecan-documentation/content/developers_guide/Adding-an-Ecosystem-Model.html
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5. Output and Visualization 

 

For now focus on graphs, we will explore all of PEcAn’s outputs in more detail in Demo 2. 

 

1. Graphs 
1. Select a Year and Y-axis Variable, and then click 'Plot run/year/variable'. Initially 

leave the X-axis as time. 

2. Within this figure the points indicate the daily mean for the variable while the 

envelope encompasses the diurnal variability (max and min). 

3. Variable names and units are based on a standard netCDF format. 

4. Try looking at a number of different output variables over different years. 

5. Try changing the X-axis to look at bivariate plots of how different output variables are 

related to one another. Be aware that PEcAn currently runs a moving min/mean/max 

through bivariate plots, just as it does with time series plots. In some cases this makes 

more sense than others. 

2. Alternative Visualization: Shiny 

1. Open another window to URL/shiny 

2. Click on workflowPlot.  

 
 

The shiny app will automatically access your run’s output files and allow you to visualize all 

output variables as a function of time. Use the pull down menu under Variable Name to choose 

whichever output variable you wish to plot. 

 

6. Model Run Archive 
Return to the URL/pecan window and Click on the HISTORY button. Click on any previous 

run in the “ID” column to go to the current state of that run's execution -- you can always return 

to old runs and runs in-progress this way. The run you just did should be the more recent entry 

in the table. For the next analysis, make note of the ID number from your run.  

  

http://nacp.ornl.gov/MsTMIP_variables.shtml
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7. Analyzing model output 

In this final section we will compare model outputs to data outside of the PEcAn web interface. 

The goal of this is to demonstrate that it is straightforward to perform additional analyses using 

PEcAn’s outputs. To do this you can download each of the Output files, and then perform the 

analyses using whatever software you prefer, or you can perform analyses directly on the 

PEcAn server itself. Here we’ll be analyzing model outputs in R using a browser-based version 

of RStudio that’s installed on the server 

 

1. Open RStudio Server in a new window at URL/rstudio  

 
1. The username is carya and the password is illinois. 

 

2. To open a new R script click File > New File > R Script 

 

3. Use the Files browser on the lower right pane to find where your run(s) are located 

1. All PEcAn outputs are stored in the output folder. Click on this to open it up. 

2. Within the outputs folder, there will be one folder for each workflow execution. For 

example, click to open the folder PEcAn_99000000001 if that’s your workflow ID 

3. A workflow folder will have a few log and settings files (e.g. pecan.xml) and the 

following subfolders 

run  contains all the inputs for each run 

out  contains all the outputs from each run 

pft  contains the parameter information for each PFT 

 

Within both the run and out folders there will be one folder for each unique model 

run, where the folder name is the run ID. Click to open the out folder. For our simple 

case we only did one run so there should be only one folder (e.g. 99000000001). 

Click to open this folder. 

4. Within this folder you will find, among other things, files of the format <year>.nc. 



 7 

Each of these files contains one year of model output in the standard PEcAn netCDF 

format. 

 

2. Load and plot the model output 

 

library(PEcAn.utils) 

arun <- read.output(99000000001, "output/PEcAn_99000000001/out/99000000001/" 

,2006,2006,c("time","NEE")) 

plot(arun$time,arun$NEE,type='l',ylab="kg ha-1 yr-1",xlab="day of year") 

 

The arguments to read.output are the run ID, the folder where the run is located, the start 

year, the end year, and the variable being read. 

 

3. Compare model to flux observations 

 

First load up the observations and take a look at the contents of the file 

 

library(PEcAn.assim.batch) 

obs <- load.L2Ameriflux.cf("~/output/dbfiles/Ameriflux_site_0-772/US-NR1.2006.nc") 

names(obs) 

 

Here 0-722 is the database site ID, a folder that was created when you selected the site and 

PEcAn downloaded the Ameriflux NetCDF (.nc) file from the Ameriflux website.  

 

Second, change all missing values from -9999 to not a number (NA) and also u* filter the 

fluxes. Here we will apply a conservative u* of 0.2. 

 

obs[obs==-9999]=NA 

obs$NEE[obs$UST<0.2]=NA 

 

Third, convert the model to have the same units as the data 

 

modNEE <- ud.convert(arun$NEE,"kg ha-1 yr-1","ug m-2 s-1")/12.0 #12 g C per mol 

 

Fourth, plot model predictions vs. observations and compare this to a 1:1 line  

 

plot(modNEE,obs$NEE) 

abline(0,1,col="red")  ## intercept=0, slope=1 

 

Fifth, calculate the Root Mean Square Error (RMSE) between the model and the data 

 

rmse = sqrt(mean((modNEE-obs$NEE)^2,na.rm = TRUE)) 

 

Finally, plot time-series of both the model and data together 

 

plot(arun$time,modNEE,type='l',ylab="umol m-2 s-1",xlab="day of year") 

lines(arun$time,obs$NEE,col="green") 
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DEMO 2: Ensemble & Sensitivity Analyses 

 

In Demo 2 we will be looking at how PEcAn can use information about parameter uncertainty to 

perform three automated analyses: 

 Ensemble Analysis: Repeat numerous model runs, each sampling from the 

parameter uncertainty, to generate a probability distribution of model 

projections. Allows us to put a confidence interval on the model 

 Sensitivity Analysis: Repeats numerous model runs to assess how changes in 

model parameters will affect model outputs. Allows us to identify which 

parameters the model is most sensitive to. 

 Uncertainty Analysis: Combines information about model sensitivity with 

information about parameter uncertainty in order to determine the 

contribution of each model parameter to the uncertainty in model outputs 

seen in the Ensemble Analysis. Allow us to identify which parameters are 

driving model uncertainty. 

 

1. Return to the main menu for the PEcAn web interface: URL/pecan  

 

2. Repeat the steps for site selection and run specification, however this time click to turn on 

“Edit pecan.xml” and also “Advanced setup” 

 

3. By clicking Advanced setup, PEcAn will first show an Analysis Menu, where we are going 

to specify new settings. 

 
 

1. For an ensemble analysis, increase the number of runs in the ensemble, in this case to 

100. In practice you would want to use a larger ensemble size (100-5000) than we are 

using in the demo. The ensemble analysis samples parameters from their posterior 

distributions to propagate this uncertainty into the model output. 

 

2. PEcAn's sensitivity analysis holds all parameters at their median value and then varies 

each parameter one-at-a-time based on the quantiles of the posterior distribution. PEcAn 

also includes a handy shortcut, which is the default behavior for the web interface, that 

converts a specified standard deviation into its Normal quantile equivalent (e.g. 1 and -1 

are converted to 0.157 and 0.841). In this example set Sensitivity to -2,-1,1,2 (the 

median value, 0, occurs by default). 
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We also can tell PEcAn which variable to run the sensitivity on. Here, replace NPP with 

NEE, so we can compare against flux tower NEE observations. 

 

Click Next 

 
3. Advanced Edit (optional) 

 
 

Advanced Edit lets you edit the pecan.xml settings file, which lets you control additional 

parameters not enabled on the web interface and turn on additional analyses, such as 

state and parameter data assimilation and benchmarking. For example, the Ensemble 

and Sensitivity settings the XML let your control variables such as start and end year of 

the analysis separately from the years of the run itself 

 

“Save” any changes then click “Continue” 

 

4. Additional Outputs: 

The PEcAn workflow will take considerably longer to complete since we have just asked 

for over a hundred model runs. Once the runs are complete you will return to the output 

visualization page were there will be a few new outputs to explore, as well as outputs that 

were present earlier that we’ll explore in greater details: 

 

1. Run ID: 

While the sensitivity and ensemble analyses synthesize across runs, you can also select 

individual runs from the Run ID menu. You can use the Graphs menu to visualize each 

individual run, or open individual runs in URL/shiny/workflowPlot/  

 

2. Inputs: 

This menu shows the contents of /run which lets you look at and download: 

https://pecan.gitbooks.io/pecan-documentation/content/users_guide/advanced_users_guide/PEcAn-Configuration.html


 10 

1. A summary file (README.txt) describing each run: location, run ID, model, dates, 

whether it was in the sensitivity or ensemble analysis, variables modifed, etc. 

2. The model-specific input files fed into the model 

3. The jobs.sh file used to submit the model run 

 

3. Outputs: 

This menu shows the contents of /out. A number of files generated by the underlying 

ecosystem model are archived and available for download. These include: 

1. Output files in the standardized netCDF ([year].nc) that can be downloaded for 

visualization and analysis (R, Matlab, ncview, panoply, etc) 

2. Raw model output in model-specific format (e.g. sipnet.out). 

3. Logfile.txt contains job.sh & model error, warning, and informational messages 

 

4. PFTs:  

This menu shows the contents of /pft. There is a wide array of outputs available that are 

related to the process of estimating the model parameters and running 

sensitivity/uncertainty analyses for a specific Plant Functional Type.  

1. TRAITS: The Rdata files trait.data.Rdata and madata.Rdata are, respectively, the 

available trait data extracted from the database that was used to estimate the model 

parameters and that same data cleaned and formatted for the statistical code. The list 

of variables that are queried is determined by what variables have priors associated 

with them in the definition of the PFTs. Priors are output into prior.distns.Rdata. 

Likewise, the list of species that are associated with a PFT determines what subset 

of data is extracted out of all data matching a given variable name. Demo 3 will 

demonstrate how a PFT can be created or modified. To look at these files in RStudio 

click on these files to load them into your workspace. You can further examine them 

in the Environment window or accessing them at the command line. For example, 

try typing names(trait.data) as this will tell you what variables were extracted, 

names(trait.data$Amax) will tell you the names of the columns in the Amax 

table, and summary(trait.data$Amax) will give you summary data about the 

Amax values. 

2. META-ANALYSIS: 

1. *.bug: The evaluation of the meta-analysis is done using a Bayesian statistical 

software package called JAGS that is called by the R code. For each trait, the R 

code will generate a [trait].model.bug file that is the JAGS code for the 

meta-analysis itself. This code is generated on the fly, with PEcAn adding or 

subtracting the site, treatment, and greenhouse terms depending upon the 

presence of these effects in the data itself. If the <random.effects> tag is set 

to FALSE then all random effects will be turned off even if there are multiple 

sites.  

2. meta-analysis.log contains a number of diagnostics, including the 

summary statistics of the model, an assessment of whether the posterior is 

consistent with the prior, and the status of the Gelman-Brooks-Rubin 

convergence statistic (which is ideally 1.0 but should be less than 1.1).  

3. ma.summaryplots.*.pdf are collections of diagnostic plots produced in 

R after the above JAGS code is run that are useful in assessing the statistical 

model. Open up one of these pdfs to evaluate the shape of the posterior 

distributions (they should generally be unimodal), the convergence of the 
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MCMC chains (all chains should be mixing well from the same distribution), 

and the autocorrelation of the samples (should be low). 

 

4. traits.mcmc.Rdata contains the raw output from the statistical code. This 

includes samples from all of the parameters in the meta-analysis model, not just 

those that feed forward to the ecosystem, but also the variances, fixed effects, 

and random effects.  

5. post.distns.Rdata stores a simple tables of the posterior distributions for 

all model parameters in terms of the name of the distribution and its parameters.  

6. posteriors.pdf provides graphics showing, for each model parameter, the 

prior distribution, the data, the smoothed histogram of the posterior distribution 

(labeled post), and the best-fit analytical approximation to that smoothed 

histogram (labeled approx). Open posteriors.pdf and compare the posteriors to 

the priors and data. 

 

3. SENSITIVITY ANALYSIS 

1. sensitivity.analysis.[RunID].[Variable].[StartYear].[EndYear].pdf 
shows the raw data points from univariate one-at-a-time analyses and spline fits 

through the points. Open this file to determine which parameters are most and 

least sensitive 

4. UNCERTAINTY ANALYSIS  

1. variance.decomposition.[RunID].[Variable].[StartYear].[EndYear].pdf, 

contains three columns, the coefficient of variation (normalized posterior 

variance), the elasticity (normalized sensitivity), and the partial standard 

deviation of each model parameter. Open this file and answer the following 

questions: 

2. The Variance Decomposition graph is sorted by the variable explaining the 

largest amount of variability in the model output (right hand column). From this 

graph identify the top-tier parameters that you would target for future constraint.   

3. A parameter can be important because it is highly sensitive, because it is highly 

uncertain, or both.  Identify parameters in your output that meet each of these 

criteria. Additionally, identify parameters that are highly uncertain but 

unimportant (due to low sensitivity) and those that are highly sensitive but 

unimportant (due to low uncertainty). 

4. Parameter constraints could come from further literature synthesis, from direct 
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measurement of the trait, or from data assimilation. Choose the parameter that 

you think provides the most efficient means of reducing model uncertainty and 

propose how you might best reduce uncertainty in this process. In making this 

choice remember that not all processes in models can be directly observed, and 

that the cost-per-sample for different measurements can vary tremendously (and 

thus the parameter you measure next is not always the one contributing the most 

to model variability). Also consider the role of parameter uncertainty versus 

model sensitivity in justifying your choice of what parameters to constrain. 

5. PEcAn Files: 
This menu shows the contents of the root workflow folder that are not in one of the 

folders indicated above. It mostly contains log files from the PEcAn workflow that are 

useful if the workflow generates an error, and as metadata & provenance (a detailed 

record of how data was generated). 

1. STATUS gives a summary of the steps of the workflow, the time they took, and 

whether they were successful 

2. pecan.*.xml are PEcAn settings files 

3. workflow.R is the workflow script  

4. workflow.Rout is the corresponding log file  

5. samples.Rdata contains the parameter values used in the runs. This file 

contains two data objects, sa.samples and ensemble.samples, that are the parameter 

values for the sensitivity analysis and ensemble runs respectively 

6. sensitivity.output.[RunID].[Variable].[StartYear].[EndYear].Rdata 
contains the object sensitivity.output which is the model outputs corresponding to 

the parameter values in sa.samples. 

7. ENSEMBLE ANALYSIS 
1. ensemble.Rdata contains contains the object ensemble.output, which is the 

model predictions at the parameter values given in ensemble.samples. 

2. ensemble.analysis.[RunID].[Variable].[StarYear].[EndYear].pdf 
contains the ensemble prediction as both a histogram and a boxplot. 

3. ensemble.ts.[RunID].[Variable].[StartYear].[EndYear].pdf contains a 

time-series plot of the ensemble mean, median, and 95% CI 
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6. Global Sensitivity: Shiny 

Navigate to URL/shiny/global-sensitivity.  

 
This app uses the output from the ENSEMBLE runs to perform a global Monte Carlo 

sensitivity analysis. There are three modes controlled by Output type: 

1. Pairwise looks at the relationship between a specific parameter (X) and output (Y) 

2. All parameters looks at how all parameters affect a specific output (Y) 

3. All variables looks at how all outputs are affected by a specific parameter(X) 

In all of these analyses, the app also fits a linear regression to these scatterplots and 

reports a number of summary statistics. Among these, the slope is an indicator of global 

sensitivity and the R2 is an indicator of the contribution to global uncertainty 

 

 

 

The next set of tutorials will focus on the process of data assimilation and parameter estimation. The 

next two steps are in “.Rmd” files which can be viewed online at:  

  https://github.com/PecanProject/pecan/tree/master/documentation/tutorials  

https://github.com/PecanProject/pecan/tree/master/documentation/tutorials
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Additional material 

 

In addition to the materials below you are encouraged to take a look at the Site-Level Runs section on 

the PEcAN wiki (https://github.com/PecanProject/pecan/wiki/Getting-started#site-level-runs) which 

describes the process of setting up a new site, new meteorology, new PFT, etc.   

 

Additional useful information on the wiki includes: how to report bugs, how to sync your PEcAn 

database with others, how to grab the latest “development” branch of the PEcAn code, how to 

install PEcAn on a server, how to add new models and data processing modules, and how to add 

new code to PEcAn. 

 

Currently, the web interface does not have access to all of PEcAn’s functionality. For additional tasks 

we will need to work in the statistical programming language R. To make this easier we have installed a 

brower-based R interface, RStudio Server (http://rstudio.org), on the VM. 

 

1. Open RStudio Server: 

 

1. Open up a second window on your web browser to URL/rstudio 

If you closed your previous PEcAn session, make sure the first window is open and 

points to URL/pecan 

 

2. The username for the VM is carya and the password is illinois. 

 

3. You do not need to do this now, but FYI it is also possible to ssh into the virtual machine 

using the following command in terminal: 

ssh -l pecan -p 6422 localhost 

 

 
 

https://github.com/PecanProject/pecan/wiki/Getting-started#site-level-runs
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2. Open PEcAn settings file 

 

1. Go back to URL/pecan and note the Run ID for your model run. 

In the visualization window this is listed in the top left pull-down menu 

 

3. PEcAn Workflow 

 

1. In the Files window, go to the Home > pecan > web directory 

 

2. Open the file workflow.R. This script provides an example of some of the high-level 

modules within PEcAn and we will use it to run the meta-analysis, sensitivity analysis, 

ensemble analysis, and variance decomposition.  

 

1. Re-run the sensitivity analysis and variance decomposition for a different output variable, time 

period, site, or PFT and compare results with first site. 

1. If you are only changing the output variable or time period, you don't need to re-run the 

whole workflow since all the output variables are in the model output files. You can modify 

the pecan.xml settings object within R and run the workflow from the extraction of the 

output from the model runs onward (from get.model.output on) 

2. If you are running a new site, it is generally a good idea to do a single test run first to make 

sure the model behaves sensibly before conducting hundreds of (potentially uninformative) 

runs. 

2. Use the web database interface to change priors, define a new site, or define a new PFT 

1. Open up a new browser window to URL/bety. This page is the web-interface to the database 

underlying PEcAn – it started as an independent project as part of our biofuel work, 

hence the name BETY-db, but is now much more generic (apologies for the fact that 

web design has not kept up).  For those that are interested the full version of the database 

is at betydb.org. 

2. To modify or add a new Plant Functional Type (PFT), or to change a PFT's priors, navigate 

on the grey menu bar to Data > PFTs 

1. To add a new pft, click “new PFT” at the top and enter a name and description.  

2. To add new species to a PFT click on [+] View Related Species and type the species, 

genus, or family you are looking for into the Search box.  Click on the + to add. 

3. To remove a species from a PFT, click on [+] View Related Species and click on the X 

of the species you want to remove from the PFT. 

4. To remove a prior, click [-] View Related Prior and click on the X of the variable who's 

prior you want to remove. This will cause the parameter to be excluded from all 

analyses (meta-analysis, sensitivity analysis, etc) and revert to its default value. 

5. To add a prior, choose one from the white box of priors on the right to choose. 

6. To view the specification of a prior, or to add a new prior, click BETY-DB > Priors and 

enter the information on the variable, distribution name, distribution parameters, etc. N 

is the sample size underlying the prior specification (0 is ok for uninformative priors).  

7. You can also got to Data > Variables in order to use the search function to find an 

existing variable (or create a new one). Please try not to create new variables 

unnecessarily (e.g. changes of variable name or units to what your model uses is handled 

internally, so you want to find the trait with the correct MEANING). 

3. To add a new site 

1. The database currently requires that a site be associated with a citation. Navigate to  > 

CITATIONS and select a reference for the study site by clicking the check mark, or 
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create a new citation (creating a 'pers. communication' or 'unpublished data' citation IS 

allowed) 

2. Click on the New Site button.  Fill out at least a name and lat/lon (which can be done by 

hand or by clicking on the map). 

3. To upload model driver data [or any other input data] for the site (currently required in 

order to run the model at a site) 

1. Select RUNS > INPUTS 

2. At the bottom of the page click on New Input 

3. Choose your site from the pulldown menu 

4. Set the date range, file format, and other meta-data 

5. Click “Create” 

6. To associate the Input record in the database, click “Edit” and then “New File” 

7. Select the machine that the file is on (pecan32 is the VM itself) and fill in the 

directory path where the file is located and the file name 

8. Click Update 

 

Citation: 

LeBauer D, Wang D, Richter KT, Davidson CC, Dietze MC (2013) Facilitating feedbacks between 

field measurements and ecosystem models. Ecol Monogr 83:133–154.  
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